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Managementul proiectelor software 
Laboratorul 10 
 
 

Analiza progresului financiar 
 

1. Înţelegerea valorii câştigate 
2. Evaluarea costurilor de informaţii 
3. Efectuarea de ajustări în timpul proiectului 
4. Aplicaţii 
 
 
Când analizaţi progresul proiectului dumneavoastră, trebuie sa măsuraţi nu numai progresul 
orarului ci şi progresul bazat pe costurile pe care le suportaţi. În Microsoft Project, măsuraţi 
valoarea câştigată a proiectului dumneavoastră. 
 
 
1. Înţelegerea valorii câştigate 
 
Valoarea câştigată este măsura pe care o folosesc managerii de proiect pentru a evalua progresul 
unui proiect, bazat pe costul muncii efectuate până la acea dată. Când MS Project calculează 
valoarea câştigată, compară în mod implicit estimările iniţiale ale costurilor cu munca concretă 
efectuată ca să arate dacă proiectul se încadrează în buget. Puteţi considera valoarea câştigată o 
masură care indică cât din buget ar fi trebuit cheltuit în comparaţie cu costul muncii efectuate până 
acum, astfel luând costul de referinţă pentru task, resursă sau atribuire. 
 
Notă: Puteţi calcula valoarea câştigată înregistrând manual procentul fizic finalizat în loc să lăsaţi  
MS Project să calculeze procentul finalizat, care este de fapt durata împărţită la durata totală.  
 
Pentru a folosi şi a lucra cu  informaţiile despre valoarea câştigată în mod eficient, trebuie mai întâi 
să efectuaţi următoarele activităţi: 
 

• Salvaţi o linie de referinţă pentru proiectul dumneavoastră 
• Atribuiţi resurse şi costuri activităţilor din proiectul dumneavoastră 
• Îndepliniţi o parte din munca la proiectul dumneavoastră 

 
 
1.1. Înţelegerea câmpurilor valorii câştigate 
 
Vă amintiţi raportul despre valoarea câştigată din Capitolul 12? Câmpurile care apar ca şi rubrici în 
acel raport apar de asemenea în diverse tabele ale valorii câştigate. Câmpurile valorii câştigate 
măsoară aspecte diferite ale acesteia. Tabelul următor traduce acronimele pe care MS Project le 
foloseşte pentru a reprezenta câmpurile valorii câştigate. 
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Trei dintre câmpurile precedente sunt cu adevărat în centrul analizei valorii câştigate, după cum 
urmează: 
 

• BCWP arată cât de mult din bugetul unei activităţi ar fi trebuit cheltuit luând durata efectivă a 
activităţii. De exemplu, să presupunem că aveţi o activitate cu bugetul de 100$ şi s-a lucrat până 
acum la ea o zi. Aflaţi că după o zi, 40% din lucru a fost îndeplinit. Va-ţi aştepta ca 40% din costul 
activităţii, sau 40$, ar fi de asemenea suportat. Prin urmare, BCWP pentru activitate este 40$. 

• BCWS măsoară costul bugetat al activităţilor individuale bazat pe resurse şi pe costurile fixe care 
sunt atribuite activităţilor când le programaţi.  

• ACWP măsoară costul efectiv care este suportat pentru a îndeplini o activitate. În timpul  
procesului de finalizare, ACWP reprezintă costurile efective pentru munca îndeplinită până la data 
respectivă. 

 
BCWS, BCWP, ACWP, SV şi CV sunt toate calculate până astăzi sau până la data de verificare a 
statusului proiectului. SV reprezintă diferenţa de cost dintre progresul current şi planul de referinţă, 
şi MS Project calculează această valoare ca BCWP minus BCWS. CV reprezintă diferenţa de cost 
dintre costurile efective şi costurile planificate la nivelul curent de finalizare, iar MS Project 
calculează această valoare ca BCWP minus ACWP. EAC arată costurile plănuite bazate pe costurile 
care sunt deja suportate plus costuri plănuite suplimentare. VAC reprezintă variaţia dintre costul 
iniţial şi combinaţia de costuri efective plus costuri plănuite pentru o activitate. 
 
Notă: MS Project calculează BCWP la nivel de activitate, diferit de cum calculează BCWP la nivel 
de atribuire. Deoarece MS Project include valorile BCWP la nivel de activitate în rezumatul 
activităţilor şi în rezumatul de activitate la nivel de proiect, sugerez folosirea valorilor BCWP la 
nivel de activitate. 
 
MS Project foloseşte BCWS, BCWP, ACWP, SV şi CV ca şi câmpuri ale activităţii, ale resursei şi 
ale atribuirii; MS Project foloseşte de asemenea versiuni „timephased” a fiecărui câmp. BAC, EAC 
şi VAC, însă, sunt doar câmpuri ale activităţii. 
 
MS Project 2003 a introdus câteva câmpuri noi ale valorii câştigate. Câteva din aceste câmpuri apar 
implicit în tabele de valori câştigate, şi se pot adăuga oricare din aceste câmpuri la orice tabelă. 
Câmpurile noi ale valorii câştigate ale MS Project sunt după cum urmează: 
 
• Procentul Fizic Finalizat (Physical % Complete): Acest câmp reprezintă estimarea 

dumneavoastră asupra progresului unei activităţi, indiferent de munca efectivă sau de timp,  şi nu 
e un câmp „timephased”. MS Project calculează Procentul Fizic Finalizat sumând BCWP din 
sub-activităţi în BCWP din rezumatul de activităţi asociat. Se introduc estimarile Procentului 
Fizic Finalizat, iar MS Project aplică Procentul Fizic Finalizat la datele de atribuire sau la datele 
de Costuri Fixe pentru rezumatul de activitate asociat. Urmăriţi următoarea secţiune pentru 
detalii cu privire la utilizarea de către MS Project a Procentului Fizic Finalizat ca şi metodă 
pentru a calcula valoarea câştigată. 
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Notă: Poate vă întrebaţi despre diferenţa dintre Procentul Finalizat (% Complete), care nu este nou 
pentru MS Project 2003, şi Procentul Fizic Finalizat (Physical % Complete). MS Project calculează 
Procentul Finalizat prin împărţirea duratei efective a activităţii cu durata totală. Procentul Fizic 
Finalizat este estimarea dumneavoastră despre progresul activităţii şi nu are legătură cu durata.  
 
• CPI (Cost Performance Index)  e calculat de către MS Project împarţind BCWP la ACWP. Acest 

câmp apare implicit în tabela Earned Value Cost Indicators şi este un câmp „timephased”. 
• SPI ( Schedule Performance Index) e calculat de către MS Project împărţind BCWP la BCWS. Acest 

câmp apare implicit în tabela  Earned Value Schedule Indicators şi este un câmp „timephased”. 
• CV% (Cost Variance %), acest câmp este calculat de către MS Project prin împărţirea lui CV la 

BCWP şi multiplicând rezultatul cu 100. Acest câmp apare implicit în tabela Earned Value Cost 
Indicators şi este un câmp „timephased”. 

• SV% (Schedule Variance %), acest câmp este calculat de către MS Project prin împărţirea lui SV la 
BCWS şi multiplicând rezultatul cu 100. Acest câmp apare implicit în tabela Earned Value Schedule 
Indicators şi este un câmp „timephased”. 

• EAC ( Estimate at Completion) , deşi acest câmp nu este nou (exista şi în MS Project 2000), 
este îmbunătăţit în MS Project 2003. MS Project calculează acest câmp folosind următoarea 
formulă: ACWP + (BAC – BCWP) / CPI. Acest câmp apare implicit în tabelele Earned Value 
for Tasks şi Earned Value Cost Indicators şi nu este un câmp „timephased”. 

 
Notă: În MS Project 2000, EAC era doar costul activităţii, pentru că EAC nu era nimic mai mult 
decât, atât, redenumit EAC. În MS Project 2003, câmpul este unul nou, bazat pe o formulă.  
 
• TCPI (To Complete Performance Index), acest câmp este calculat folosind formula:  (BAC – 

BCWP) / (EAC – ACWP). Acest câmp apare implicit în tabela Earned Value Cost Indicators şi nu 
este un câmp „timephased”. 

 
 
1.1.1. Folosirea metodei Procent Fizic Finalizat pentru a calcula valoarea câştigată 
 
MS Project poate folosi fie metoda Procent Finalizat fie metoda Procent Fizic Finalizat pentru a 
calcula valoarea câştigată. Dacă nu se specifică altfel, MS Project foloseşte metoda Procent 
Finalizat. 
 
Se poate seta Procent Fizic Finalizat ca si metoda implicită de calcul a valorii câştigate, pentru 
întreg proiectul, urmând următorii paşi: 
 
1. Alegeţi Tools → Options. 
2. Apasaţi tabul Calculation. 
3. Apasaţi butonul Earned Value. Veţi vedea fereastra de dialog Earned Value, aşa cum se poate 

observa în Figura 14-1. 
 

 
Figura 14-1: Alegeţi metoda de calcul a valorii câştigate 

pe care MS Project să o folosească 
 
4. Din listbox-ul Default task Earned Value method, alegeţi Physical % Complete. 
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5. Din listbox-ul Baseline for Earned Value calculations, alegeţi Baseline ( MS Project stochează 
11 baseline pentru valoarea câştigată). 

 
Notă: Ştergerea unui baseline după introducerea valorilor Procentului Fizic Finalizat nu şterge acele 
valori.  
 
6. Apasaţi OK de 2 ori pentru a salva setările. 
 
Paşii precedenţi setează opţiunea implicită pentru toate noile activităţi ce vor fi inserate în proiect. 
Dacă proiectul conţine deja activităţi (sau dacă se doreşte folosirea metodei Procentului Fizic 
Finalizat pentru câteva dar nu toate activităţile), se setează metoda de calcul a valorii câştigate în 
modul activitate-per-activitate. Se urmăresc următorii paşi:  
 
1. Se selectează activitatea sau activităţile pentru care se doreşte setarea metodei de calcul a valorii 

câştigate ca fiind Procentul Fizic Finalizat. 
2. Apasaţi butonul Task Information din toolbar-ul Standard. 
3. Apasaţi tab-ul Advanced. 
4. Din listbox-ul Earned value method, se alege Physical % Complete, aşa cum se poate vedea în 

Figura 14-2. 
 

 
Figura 14-2: Setează metoda Physical % Complete ca şi potrivită  

pentru activităţi, în fereastra de dialog Task Information.  
 

Pentru a marca Procentul Fizic Finalizat, adaugaţi câmpul ca şi coloană întro vizualizare a 
tabelei (Figura 14-3 , a fost adaugat în tabela Earned Value for Tasks), iar apoi se introduc 
valori potrivite pentru activităţi. Se vor putea observa cum alte câmpuri pentru valori câştigate 
se vor actualiza corespunzător. 
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Figura 14-3: Marcaţi valorile Physical % Complete prin adăugarea  

câmpului la o tabelă iar apoi introducând informaţiile. 
 
Notă: Pentru a insera o coloană, apasaţi pe rubrica coloanei de la dreapta coloanei pe care doriţi să 
o inseraţi. Apoi alegeţi Insert → Column. 
 
 
1.1.2. Setarea datei pentru calculul valorii câştigate 
 
Implicit, MS Project foloseşte data de azi pentru a calcula informaţiile despre valoarea câştigată. 
Totuşi, se poate seta data de calcul a proiectului, pentru ca MS Project să o folosească pe aceea 
atunci când calculează valoarea câştigată, în loc de data curentă. Din orice vizualizare, se alege 
Project → Project Information pentru a deschide fereastra de dialog Project Information, aşa cum se 
poate vedea în Figura 14-4.  
 
Din listbox-ul Status Date, se selectează data pe care MS Project să o folosească atunci când 
calculează valoarea câştigată şi apoi se apasă OK.  
 

 
Figura 14-4: Folosiţi această fereastră de dialog pentru a seta o dată  

pe care MS Project să o folosească atunci când calculează valoarea câştigată. 
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1.2. Folosirea tabelelor cu valori câştigate 
 
MS Project conţine 4 tabele pentru valori câştigate care pot fi folosite pentru a compara costurile 
aşteptate cu costurile efective. Cele 4 tabele - Earned Value for Tasks, Earned Value Cost 
Indicators, Earned Value Schedule Indicators şi Earned Value for Resources – ajută la evaluarea 
relaţiei dintre muncă şi costuri. Aceste tabele pot fi folosite pentru a preconiza dacă o activitate se 
va finaliza încadrându-se în buget, bazată pe comparaţia dintre costurile efective suportate pentru 
activitate până la îndeplinire şi costul iniţial al acestuia.   
 
 
1.2.1. Folosirea tabelei Earned Value for tasks 
 
Când se foloseşte tabela Earned Value for tasks, se poate compara relaţia dintre muncă şi costuri 
pentru activităţi. Această tabelă ajută la evaluarea bugetului pentru a estima nevoi viitoare de buget 
şi pentru a pregăti o declaraţie de contabilitate a proiectului. Se poate folosi informaţia din tabelă 
pentru a determina dacă se munceşte suficient de mult pentru câţi bani se plătesc, sau dacă 
activităţile necesită mai mulţi sau mai puţini bani, sau poate trebuie întrerupte. Deci, informaţiile 
din tabela Earned Value ajută la a evalua dacă banii cheltuiţi pe o activitate sunt destui, prea mulţi, 
prea puţini, sau poate pierduţi.  
 
Pentru a afişa tabela Earned Value for tasks, se poate începe din orice vizualizare care conţine o 
tabelă. Se poate ajunge la tabela din Figura 14-5, de exemplu, începând cu vizualizarea Task 
Usage. Click dreapta pe butonul Select All, apoi se alege More Tables din meniul scurtătură care 
apare. În fereastra de dialog More Tables, se selectează Earned Value şi se apasă Apply.  
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Figura 14-5: Tabelul Valorilor Câştigate pentru Activităţi 
 
Toate câmpurile din acest tabel sunt calculate, cu exceptia EAC şi BAC. Puteţi să scrieţi valori în 
aceste câmpuri pentru a schimba informaţia din tabel. 
 
Folosirea tabelului cu valori câştigate pentru resurse 
Când folosiţi tabelul cu valori câştigate pentru resurse, puteţi compara relaţia muncă-cost pentru 
resurse. Acest tabel vă ajută să evaluaţi bugetul pentru estimarea nevoilor unui buget viitor şi 
pregătirea unei situaţii financiare a proiectului dumneavoastră. Puteţi folosi informaţiile din tabel 
pentru determinarea fie dacă munca este realizată conform sumei de bani plătite sau dacă aveţi 
nevoie de mai multe/puţine resurse particulare.  
 
Pentru dispunerea tabelului de valori câstigate pentru resurse, urmăriţi următorii paşi: 

1. Porniţi in orice mod de vizualizare a resurselor, ca de exemplu pagina de vizualizare a 
resurselor. 

2. Apăsaţi Select All cu butonul drept al mouse-ului si alegeţi More Tables din scurtatura 
meniului care apare. 

3. Selectaţi Valuare Câştigată în fereastra More Tables, si apăsaţi Apply. Ecranul va arăta 
similar cu cel din Figura 14-6. 

 
Toate câmpurile în aceasta pagina sunt calculate, cu excepţia BAC. Puteţi introduce valori in acest 
câmp pentru a schimba informaţia din tabel. 
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Figura 14-6: Tabelul Valorilor Câştigate pentru Resurse 

 

 
Folosirea Indicatoriilor de Cost a Valorilor Câştigate şi Indicatoriilor de 
Program a Valorilor Câştigate 
 
Project 2003 a introdus două tabele noi similare cu tabelul Valorile Câştigate pentru Activităţi; 
singura diferenţă dintre ele este câmpurile care le găseşti în fiecare tabel. Tabelul Indicatoriilor de 
Cost a Valorilor Câştigate pentru Activităţi vă permite să comparaţi factorii variaţi de cost din 
proiectul dumneavoastra, ca în Figura 14-7. Tabelul Indicatoriilor de Program a Valorilor Câştigate 
pentru Activităţi vă permite să vă concentraţi asupra efectelor de a programa varietăţi ale costului 
proiectului dumneavoastră, ca în Figura 14-8.  
 
Pentru a afişa tabelul Indicatoriilor de Cost a Valorilor Câştigate pentru Activităţi, porniţi în orice 
vizualizare de activitate care conţine un tabel. Apoi apăsaţi click-dreapta pe butonul Select All şi 
alegeţi More Tables din scurtătura meniul care apare. În căsuţa de dialog More Tables, selectaţi 
Indicatori de Cost a Valorilor Câştigate si apăsaţi Apply. 
 
Pentru a afişa tabelul Indicatoriilor de Program a Valorilor Câştigate pentru Activităţi, porniţi în 
orice vizualizare de activitate care conţine un tabel. Apoi, apăsaţi click-dreapta pe butonul Select 
All şi alegeţi More Tables din scurtătura meniul care apare. În căsuţa de dialog More Tables, 
selectaţi Indicatori de Program a Valorilor Câştigate si apăsaţi Apply. 
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Figura 14-6: Tabelul Indicatorilor de Cost a Valorilor Câştigate aproape seamănă cu Tabelul Valorilor 

Câştigate pentru Activităţi, dar se concentrează pe câmpuri diferite de câştig de valori 
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Figura 14-8: Tabelul Indicatorilor de Program a Valorilor Câştigate aproape seamănă cu Tabelul Valorilor 

Câştigate pentru Activităţi, dar se concentrează pe câmpuri diferite de câştig de valori 
 
Evaluarea Informaţie – Cost 
 
Dacă deţineţi Microsoft Excel, puteţi să îl folosiţi să asistaţi la evaluarea cost-informaţie. Prin 
exportarea informaţiei în Excel, puteţi să afişaţi valorile câştigate, să analizaţi informaţie scalată în 
timp, sau să creaţi Tabele Pivot. 
 
Valoarea Câştigată tabelată 
 
Zicala zice: O imagine merită o mie de cuvinte. �i când ne uităm la informaţia valorii câştigate, 
poate o să o găsiţi uşor de înţeles informaţia dacă aţi folosi o imagine, decât să studiaţi tabelele 
Valorilor Câştigate ale Project 2003. Puteţi exporta informaţia valorilor câştigate în Micorsoft 
Excel(trebuie să folosiţi versiunea 5.0 Excel sau mai târzie) şi apoi folosiţi Tabela Wizard a 
Excelului să creaţi tabele de informaţie a valorilor câştigate. 
 
Pentru a descoperi mai multe despre capacităţile de export si import ale Excelului, vedeţi capitolul 
22. 
 
Când exportaţi valorile câştigate din MS Project în Excel, creaţi un workbook in Excel care conţine 
o activitate ID, un nume, şi valorile câştigate variate pentru fiecare activitate, ca în Figura 14-9. 
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Figure 14-9: Un workbook Excel care a fost creat prin exportarea informaţiei valorilor câştigate din Project in 

Excel. 
 
Pentru a crea un workbook Excel ca şi cel din Figura 14-9, urmăriţi urmatorii paşi: 

1. În fişierul din MS Project care conţine informaţia pe care vreţi să o folosiţi în Excel, alegeţi: 
File-> Save As pentru a deschide fereastra de dialog Save As. 

 
2. Tipăriţi un nume pentru workbook-ul Excel in fereastra listă New File. Nu vă faceţi griji de 

extensii: MS Project le aplica. 
 

3. Deschideţi din fereastra listă Save As Type, şi selectează Microsoft Excel Workbook. 
Fereastra dialog Save As ar trebui sa arate ca si cea din Figura 14-10. 

 
4. Apăsaţi Save ca să incepeţi exportul Mapping Wizard. 

 
5. Apăsaţi Next. 

 
6. Alegeţi Selected Data în fereastra următoare a wizard-ului, şi apoi apăsaţi Next. 
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Figura 14-10: Fereastra de dialog Save As cum apare dupa ce dumneavoastră alegeţi să salvaţi 

fişierul workbook Excel. 
 

7. Alegeţi Use existing map în următoarea fereastră a wizard-ului, şi apoi apăsaţi Next.  
 

8. Alegeţi informaţia valorilor câştigate din lista mapelor libere în fereastra de dialog a 
Wizard-ului de Export, ca şi în Figura 14-11, şi apăsaţi End. 

 
Puteţi continua apăsând Next în wizard, dar pentru tabela valorilor câştigate în Excel, de obicei nu 
trebuie făcute schimbări în fereastrele de dialog rămase pe care le prezintă wizard-ul. 
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Figura 14-11: Alegeţi informaţia valorilor câştigate ca şi harta din fereastra de dialog a Export 

Wizard-ului. 
 

Deschideţi Microsoft Excel şi apoi alegeţi File->Open pentru a deschide workbook care tocmai l-aţi 
creat. Puteţi folosi tabela Wizard a Excelului ca să creaţi atâtea tabele din acest tip câte doriţi. De 
exemplu, tabela din Figura 14-12 arată toate valorile câştigate pentru o activitate, şi tabela din 
Figura 14-13 arată o valoare câştigată pentru o activitate selectată. 
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Figura 14-12: O tabelă Excel pentru toate valorile câştigate pentru o activitate 

 
Dacă proiectul dumneavoastră este mic, se poate să puteţi să tabelaţi o valoare câştigată pentru toate 
activităţile, dar dacă proiectul dumneavoastră este mare, Excel-ul poate afişa un mesaj de eroare 
dacă incercaţi să tabelaţi o valoare câştigată pentru toate activităţile. 
 
Pentru a crea o tabelă ca şi cea afişată in Figura 14-12, urmăriţi următorii paşi: 

1. Apăsaţi butonul Tabela Wizard în bara Standard pentru a începe Tabela Wizard. În fereastra 
de dialog Tabela Wizard, selectaţi tipul de tabela pe care doriţi să o creaţi. 

 
2. Apăsaţi Next pentru a deschide a doua fereastră Tabela Wizard, cum este arătat in Figura 

14-14. În această fereastră de dialog, selectaţi Rows pentru opţiunea în Serie. 
 

3. Apăsaţi butonul Collapse Dialog la limita din dreapta a ferestrei de Data serie, care este 
arătată in Figura 14-14, pentru a ascunde Tabela Wizard astfel încât să puteţi selecta 
activitatea pe care doriţi să o tabelaţi din pagina de lucru. 
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Figura 14-13: O tabelă Excel a valorii câştigate pentru activităţile selectate 

 
 

4. Selectaţi celulele din linia conţinând informaţiile care doriţi să le tabelaţi. Observaţi că s-a 
exclus ID-ul din coloana A ca în Figura 14-15. 

 
 

 
Figura 14-14: Tabela datelor după linii 
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Figura 14-15: Selectaţi celulele care doriţi să le tabelaţi 

 
Diagrama dumneavoastră va fi mai clară dacă scoateţi Coloana A care conţine ID-ul 
(identificatorul) activităţii. 

 
5. Apăsaţi butonul Collapse Dialog  pentru a redeschide Tabela Wizard. 

 
6. Apăsaţi butonul Series Tab (pagina Serii). 

 
7. Apăsaţi butonul Collapse Dialog poziţionat în partea dreaptă a casuţei Categorie Axă (X). 

 
8. Selectaţi rubrica din Row 1 care conţine etichetele pentru câmpurile valorii câştigate. 

Selecţia dumneavoastră va conţine probabil celulele de la C1 până la J1. 
 

9. Apăsaţi butonul Collapse Dialog  pentru a redeschide Tabela Wizard. Tab-ul Serii ar trebui 
să arate ca in Figura 14-16. 

 
10. Apăsaţi Next şi completaţi celălalte casete de dialog pentru Tabela Wizard. 

 
 
După ce aţi terminat de completat, diagrama dumneavoastră ar trebui să arate ca in Figura 14-12 
care afişează toate valorile caştigate pentru o activitate. 
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Figura 14-16: Tab-ul Serii după ce aţi selectat etichetele pentru Axa X 

 
Pentru a creea diagrama afişată în Figura 14-13 folosiţi din nou Tabela Wizard. Apoi în a doua 
casetă de dialog a Tabelei Wizard utilizaţi următoarele setări: 
 

 În tab-ul Data Range, selectaţi Columns pentru opţiunea Series in. Pentru Data Range 
selectaţi celulele conţinând valoarea caştigată care doriţi să o tabelaţi. În diagrama din 
Figura 14-13 am tabelat doar jumatate din activităţile disponibile pentru a menţine diagrama 
curată. 

 
 În tab-ul Series(Serii) înlăturaţi toate seriile păstrând doar una din lista Serii (altfel diagrama 

va fi foarte încurcată). În căsuţa corespunzătoare etichetei Categorie Axa (X) selectaţi doar 
celulele care conţin numele activităţilor (celulele din coloana B din pagina de lucru afişată). 

 
Analiza Informaţiilor de Timp 
 
MS Project conţine un Wizard care vă ajută să tabelaţi valorile de timp caştigate. Puteţi utiliza 
Wizard-ul Analiza Datelor de Timp pentru a creea automat o digramă in Microsoft Excel conţinând 
valoarea câştigată pentru întregul proiect. După terminarea ghidului diagrama rezultată va arata ca 
in Figura 14-17. 
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Figura 14-17: Diagrama cu valorile câştigate rezultată în Excel folosind Wizard-ul Analiza Datelor de Timp 

din MS Project. 
 

Pentru a utiliza Wizard-ul Analiza Datelor de Timp în MS Project executaţi paşii următori: 
 

1. Alegeţi View, apoi Gantt Chart(Diagrama Gantt). 
Pentru a tabela datele pentru anumite activităţi selectaţile acum. 
 

2. Alegeţi View, apoi Toolbars, apoi Analysis. MS Project va afişa Bara de instrumente pentru 
Analiză ca in Figura 14-18. 

 
 

Figura 14-18: Bara de instrumente pentru Analiză 
 

Veţi fi nevoit să apăsaţi butonul More de la extremitatea dreapta la Barei de instrumente 
pentru a vedea si a apăsa butonul Analiza Datelor de timp în Excel. 

 
3. Apăsaţi butonul Analiza Datelor de timp în Excel. MS Project va dechide primele cinci 

căsuţe de dialog din Wizard-ul Analiza Datelor de Timp ca in Figura 14-19. 
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Figura 14-19: Prima căsuţă de dialog din Wizard-ul Analiza Datelor de Timp. 

 
4. Selectaţi opţiunea Tot Proiectul sau Activităţile selectate în prezent şi apăsaţi Next pentru a 

deschide căsuţa de dialog de la pasul 2. 
 
5. Selectaţi câmpurile cu valoarea câştigătoare corespunzătoare din lista cu activităţile 

disponibile; apăsaţi Adaugă pentru a muta câmpurile selectate in Lista Câmpurilor pentru 
Export. Selectaţi câmpul Word din Lista Câmpurilor pentru Export şi apăsaţi butonul Şterge 
ca in Figura 14-20. 
 

 
Figura 14-19: Selecţia câmpurilor pentru Export in Excel. 

 
6. Selectaţi intervalul de timp şi unitatea de măsură pentru incrementare care doriţi sa le 

utilizaţi. Zile este unitatea de măsură pentru incrementare implicit selectată care vă este 
ilustrată în Figura 14-21. Apăsaţi Next pentru a merge la pasul 4. 

 
7. Selectaţi butonul Da, vă rog pentru a ilustra datele cum vă este prezentat în Figura 14-22. 

Altfel puteţi selecta butonul Nu, vă mulţumesc. Apăsaţi Next pentru a afişa ultima căsuţă de 
dialog a wizard-ului. 
 

8. Apăsaţi Export pentru a exporta datele proiectului în Microsoft Excel ca în Figura 14-23.  
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Figura 14-21: Selectaţi intervalul de timp şi unitatea de măsură pentru incrementare pentru care 

doriţi să exportaţi Datele. 
 

 
Figura 14-22: Spuneţi Wizard-ului daca doriţi sau nu să afişaţi Datele rezultate. 

 

 
Figura 14-23: Terminaţi procesul prin a exporta Datele in Excel. 
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După ce aţi terminat, la mouse se va afişa o clepsidră ceea ce inseamnă că trebuie să aşteptaţi până 
când se incheie acţiunea in desfăşurare. Se va deschide Excel, vor fi procesate datele şi se va afişa o 
tabelă ca în Figura 14-17 (figură aflată la inceputul acestui paragraf). Excel creează si o pagină de 
lucru pe care o puteţi vizualiza selectând tab-ul Datele de Timp ca în Figura 14-24. Pagina de lucru 
conţine informaţiile despre valoarea câştigată folosite de Excel la crearea diagramei din Figura 14-
17. 
 

 
Figura 14-23: Pagina folosită de Excel la crearea diagramei. 

 

Folosirea Tabelelor Pivot pentru Analiză 
  
Tabelele Pivot din excel pot fi interesante si ajutătoare atunci când doriţi să analizaţi valoarea 
caştigată din MS Project. Tabela Pivot este o tabelă interactivă care sintetizează cantităţi mari de 
date într-o trans-format tabelar. Când utilizaţi MS Project pentru a crea o Tabelă Pivot în Excel 
obţineţi două tabele Pivot în aceiaşi pagină de lucru: o Tabelă Pivot Activitate şi o Tabelă Pivot 
Resursă. Tabela Pivot Activitate afişează resurse, activităţi în care resursele sunt alocate, precum si 
costurile de resursă pe activitate. Tabela Pivot Resursă rezumă resursele de lucru prin afişarea 
muncii atribuite fiecareia şi costul total pentru fiecare resursă de lucru. În plus faţă de paginile de 
lucru al Tabelei Pivot, aceliaşi fişă de lucru din Excel include, de asemenea, două fişe de lucru -  
Activităţi şi Resurse – pe care Excel le utilizează pentru a crea aceste două Tabele Pivot. 
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Pentru a exporta din Microsoft Project informaţiile pentru a crea tabele pivot în Excel , trebuie 
urmaţi următorii paşi: 
 

1. Se porneşte din orice vizualizare a proiectului. 
2. Se alege File → Save as pentru a deschide fereastra de dialog Save as 
3. Se scrie un nume in caseta File name pentru fişierul Excel pe care doriţi să îl creaţi . 

Extensia este adaugată automat de Project. 
4. Selectaţi Microsoft Excel PivotTable din lista cu tipuri Save as 
5. Daţi click pe Save pentru a lansa Export Mapping Wizard 
6. Daţi click pe Next 
7. Selectaţi Use existing map şi apoi daţi click pe Next 
8. Selectaţi Task and resource PivotTable şi apoi daţi click pe Finish, ca în Figura 14-25. 
 

 

 
Figura 14-25. Porţiunea de Map Selection 
al casetei de dialog Export Mapping Wizard 

 
 
Notă: Poţi continua sa apeşi Next in vrăjitor, dar pentru a mapa valorile în Excel de obicei nu este 
nevoie să se facă alte schimbări în restul căsuţelor de dialog pe care le prezintă vrăjitorul. 
 
Iconiţa in formă de clepsidră pentru pointerul mouse-ului apare, indicând că trebuie să se aştepte cât 
timp acţiunea este executată. Se va auzi de asemenea şi hard disk-ul lucrând. Pentru a vizualiza 
tabelele pivtot şi datele conţinute de acestea, porniţi Excel si deschideţi fişierul tocmai creat. Acesta 
conţine patru foi de calcul ce ar trebui să semene cu foile de calcul prezentate în Figurile 14-26, 14-
27, 14-28 şi  14-29. 
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Figura 14-26. Tabela pivot a resurselor 

 
 
 

 
Figura 14-27. Foaia de calcul pe care Excel o foloseşte pentru a crea  

Tabelul pivot al resurselor 
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Figura 14-28. Tabela pivot a activităţilor 

 
 
 
 

 
Figura 14-29. Foaia de calcul a activităţilor pe care Excel o foloseşte 

pentru a crea tebela pivot a activităţilor 
 

Sfat: Este posibil ca pentru vizualizarea datelor în intregime să fie necesară laţirea coloanelor in 
Excel. Daţi dublu click pe limita din dreapta a coloanei literei. 
 
 
 
 
 
 



 25

Efectuarea de ajustări in timpul proiectului 
 
După ce au fost trecute in revistă modalităţile variate prin care se pot colecta şi analiza datele 
financiare ale proiectului, trebuie să se folosească aceste informaţii penru a aduce îmbunătăţiri 
acestuia. Pentru aceasta pot fi folosite multe din tehnicile care erau folosite pentru a implementa 
schimbările cauzate de problemele de planificare sau conflictele vizavi de resurse. 
 
Află cum poţi trata problemele de planificare folosind tehnicile discutate în Capitolul 9. Poţi găsi 
ajutor pentru a rezolva problemele ce ţin de resurse în Capitolul 10. 
 
Schimbarea planificării 
 
Dupa evaluarea informaţiilor despre valorile câştigate, e posibil să se dorească schimbarea 
planificării. De exemplu, se poate dori efectuarea unei din opţiunile următoare: 
 

• Adăugare de resurse la activităţi 
• Folosirea de ore suplimentare 
• Creşterea duratei activităţii 
• Ajustarea perioadei de inactivitate 
• Schimbarea constrângerilor activităţii 
• Ajustarea dependinţelor 
• Împărţirea activităţilor 
• Ajustarea căii critice 

 
Este posibil să fie necesare efectuarea unor modificări şi asupra proiectului iniţial care a fost salvat. 
 
Modificarea atribuirii resurselor 
 
Evaluarea informaţiilor despre valorile caştigate poate stimula efectuarea de modificări asupra 
atribuirii de resurse in cadrul proiectului. De exemplu, este posibil sa se facă urmatoarele: 
 

• Schimbarea alocării resurselor 
• Planificarea de ore suplimentare 
• Redefinirea calendarului unei resurse 
• Atribuirea de lucru cu jumătate de norma 
• Să se controleze momentul când resursele încep să lucreze la o activitate 
• Nivelarea gradului de încărcare a resurselor 
• Conturarea resurselor 
• Punerea în comun a resurselor 

 
Când se lucrează pe un proiect neobişnuit de mare, poate părea mai uşoară despărţirea acestuia în 
porţiuni mai mici, mai uşor de mânuit denumite subproiecte. În Microsoft Project se pot crea 
subproiectele şi apoi se poate realiza unirea acestora într-un proiect mai mare pentru a avea o 
imagine de ansamblu (a se vedea Capitolul 15). 
 
 
 
 



Aplicaţie 
 

Să considerăm un proiect care durează 18 săptămâni iar costurile planificate ale proiectului, 

pe fiecare săptămână, sunt prezentate în figura 1. Activităţile sunt deja introduse în proiectul  

Cost analysis.mpp. 

 
Notă: Datele au fost preluate din următoarea sursă: Helsinki University of Technology, 

https://noppa.tkk.fi/noppa/kurssi/tu-22.1120/materiaali/the_second_exercise_of_the_english_course_version.pdf 

 

 
Figura 1. Bugetul planificat 

 

După urmărirea proiectului timp de 9 săptămâni situaţia este aceea din figurile 2 şi 3. În 

fiecare săptămână, proiectul a costat sumele din figura 2, iar activităţile au avut gradul de 

completare din figura 3. 

 

 
Figura 2. Costurile efective 

 

 
Figura 3. Gradul de completare a activităţilor 



Realizaţi un grafic al modului de realizare al proiectului pe cele 9 săptămâni, considerând 

următoarele câmpuri ale valorii dobândite: 

 

 BCWS: cât ar fi trebuit realizat din proiect 

 BCWP: valoarea a ceea ce s-a făcut 

 ACWP: cât s-a cheltuit 

 

Opţional, se pot reprezenta şi următoarele câmpuri: 

 

 CV = BCWP – ACWP 

 SV = BCWP – BCWS 

 CPI = BCWP / ACWP 

 

 

Indicaţii: 
 

 Pentru simplitate, se poate introduce o singură resursă generică, cu un cost fix, de exemplu 

100 de unităţi/oră, care să fie atribuită la toate activităţile. Costurile pe săptămână (din 

figurile 1 şi 2) vor rezulta din atribuirea unui volum diferit de muncă la fiecare activitate pe 

săptămână, de exemplu stabilirea numărului de ore pe săptămână în tabelul Resource Usage. 

În funcţie de rezoluţia ecranului, se poate face zoom pe 45 de zile ca să apară orele pe 

săptămână. Disponibilitatea resursei trebuie să fie cuprinzătoare, adică mai mare de 100%, 

pentru a nu apărea probleme legate de orele suplimentare. Activităţile trebuie marcate Fixed 

Duration pentru a nu se modifica graficul de lucru atunci când se schimbă numărul de ore 

alocat. 

 

 
 

 
 

 După ce introduceţi toate datele din figura 1, salvaţi linia de bază.  

 

 Apoi introduceţi datele din figura 2, privind lucrul efectiv. Observaţi, de exemplu, cum 

prima activitate trebuia iniţial să dureze 1 săptămână şi să coste 2500 de unităţi şi în 

derularea efectivă a proiectului durează 2 săptămâni şi costă 3000 de unităţi. 



 
 

 Gradul de completare corespunde mărimii Physical % Complete. Acest lucru trebuie 

reflectat în metoda de calcul al valorii dobândite (vezi figurile 14-1 şi 14-2). 

 

 Probleme posibile: dacă BCWS este 0, trebuie salvată linia de bază. Indicatorul BCWP 

devine diferit de 0 când gradul de completare este diferit de 0. Dacă BCWP rămâne 0, 

trebuie efectuată operaţia Calculate project (prin setările implicite, aceasta se realizează 

automat). 

 

 Pentru analiza săptămânală, se va modifica succesiv valoarea Status Date din Project 

Information (vezi figura 14-4). În fiecare săptămână trebuie introduse valorile efective. De 

exemplu, prima activitate are alocată în linia de bază 1 săptămână, însă în realitate durează  

2 săptămâni, iar după prima săptămână activitatea este finalizată doar în proporţie de 85%. 

 

 

Săptămâna 1: 

 

 
 

 
 

 

 

 

 

 

 

 

 

 



Săptămâna 2: 

 

 
 

 
 

 

 Se poate vedea la prima activitate cum costul bugetat este de 2500 de unităţi, iar costul 

actual este de 3000 de unităţi după terminare. În săptămâna 3 şi ulterior, gradul de 

completare al primei activităţi rămâne 100%. 

 

 Este suficientă reprezentarea unui singur indicator (de exemplu ACWP), pentru toate 

activităţile, timp de 9 săptămâni, pentru a vedea cum se acumulează costurile – evoluţia 

costurilor este monoton crescătoare. 

 

 Pentru reprezentarea grafică, în loc de Microsoft Excel se poate folosi programul OpenOffice 

Calc, care pemite importarea unui workbook (*.xls) exportat de Microsoft Project. 

  




